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Stack and its approved distributors provide a comprehensive Technical Help service to assist
with your enquiries. Contact Stack for details of the dealer nearest you.
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CHAPTER 1. INTRODUCING THE STACK SYSTEM

Scope of this manual

The Stack Display System supplied with your car interfaces with the Bosch ECU model MS3.1.
Engine data is communicated from the ECU to the Stack system through a CanBus network.
Other vehicle parameters are recorded directly by the Stack system.

The supplied system provides both the driver display and data acquisition functions on the
car.

This manual explains how to use your Stack System correctly and how to get the most benefit
out of the system.

The following items are provided by Stack
Quantity | Description
1 CanBus interface Module (913034)
1 Display Module (ST868)
1 Recorder Module (ST829)
1 Stack system loom (900093)
1 Infra-red Lap Time Receiver (ST543)
1 Infra-red Lap Time Beacon (ST544)
1 PC Download interface and cable (ST890)
1 PC Sofiware — Level 2
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CHAPTER 2. OPERATING THE DISPLAY SYSTEM
The Display Module consists of an analog tachometer and a digital display panel.

When you first switch the ignition on (without the engine running) the digital display will
immediately show a “Low Oil P” warning and the alarm light will
come on.

The tachometer will reset itself by moving the nee-
dle until it touches the stop-pin, and then moving
it back to the zero RPM position. Press Switch 3 to
clear the warning message from the display. (Switch
2 can also be used for this.)

The digital display panel and the analog dial face
are always backlit when the system is switched on.

If none of these actions occurs when you switch on, switch off the power to the system and
consult the section on troubleshooting in this manual.

Changing the display layers
Each of the display layers can be displayed in turn by pressing Switch 3.

Display Layer 1
Display layer 1 shows:

Water Temperature (WATER)
Oil temperature (OIL T)
Current speed (SPEED).

Oil Pressure (OIL P)

Press Switch 3 to see display layer 2.

Display Layer 2

Display layer 2 shows:
Battery voltage (BATT)
Oil Temperature (OIL T)

Fuel Pressure (FUELP)
QOil Pressure (OIL P)

Press Switch 3 to change display to layer 3

© Stack Limited
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Display Layer 3
Display layer 3 shows:

Top Row
* Water Temperature

® Gear Temperature

Bottom Row
¢ Air Temperature

* Qil Pressure
Press Switch 3 to change the display to layer 4

Display Layer 4
Display layer 4 shows:

* Lap number (LAP No) of last completed
lap

* Lap time for last completed lap
* Current Speed (SPEED)

* Fastestlap time (BEST) (only the seconds and milliseconds parts of the lap time are shown)
Press Switch 3 to return to layer 1.

Peak Values (Tell Tales)
The system can display the peak values (sometimes called ‘tell-tales’) that have been recorded
during a run for all the monitored parameters.

Peak values are updated only when the engine speed has exceeded its “gate value” for RPM
for at least one second. This allows the values to stabilise. Blipping the engine may not be
enough to update the peak values. The gate value is a predefined RPM value that is used to
control when the system updates the peak values. This is to prevent abnormal peak values
from being recorded when, for example, the engine is either not running, is idling, or is being
warmed up.

© Stack Limited
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The system stores either a maximum or a minimum value as the peak value, depending on
the parameter, as follows:

Parameter Type of Peak Value Gated to RPM
Engine Speed (RPM) Maximum Yes
Oil Temperature Maximum Yes
Water Temperature Maximum Yes
Oil Pressure Minimum Yes
Fuel Pressure Minimum Yes
Air Temperature Maximum Yes
Gear Temperature Maximum Yes
Battery Voltage Minimum Yes
Wheel Speed Maximum Yes

Displaying the Peak Values
Press and hold Switch 1 to show the peak values for the parameters currently being dis-
played. Release the switch to return to the normal display.

Resetting the Peak Values

You can reset all of the peak values, except the fastest lap time, manually. All peak values are
reset at the same time. If the engine is running at or above its gate value when the peak
values are reset, they are set to the current value of each performance parameter.

To reset the peak values:
* Press and hold Switch 1 to display the peak values.

* While holding Switch 1, press and hold Switch 3.

*  With Switch 3 held down, you will see the display revert to the current values. The new
peak values that are stored are those being displayed when you release Switch 3.
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Peak Value Memory

The peak values are stored in a memory, which is powered by an internal back-up battery.
They remain stored in this memory when the external power source is disconnected from
the system. The internal battery needs to be changed every 4-5 years. An alarm is triggered
when the power from this battery drops below a safe level and the warning “MEM BATT” is
displayed.

Alarms

The Display System has built-in warnings to alert the driver when certain parameters either
exceed or fall below their alarm values. For example, a warning is signalled if the fuel pres-
sure falls below its alarm value or if the oil temperature rises above its alarm value. You can
adjust the pre-set alarm levels when you configure the Display System. See Chapter 4,
configuring the Display System in this manual.

Some of the warnings (see the following table) are triggered only while the engine speed
exceeds its “Mask value” for RPM for at least one second. Blipping the engine may not be
enough to trigger a warning. The mask value is a predefined RPM value that is used to
control when the system is to trigger a warning. This is to prevent abnormal warnings from
being triggered when, for example, the engine is either not running, is idling, or is being
warmed up.

The Display System has the following built-in alarms:

Parameter Alarm is triggered when the: Gated to RPM
Oil Temperature current value exceeds the pre-set value Yes
Water Temperature current value exceeds the pre-set value Yes
Oil Pressure current value drops below the pre-set value No
Air Temperature current value exceeds the pre-set value Yes
Gear Temperature current value exceeds the pre-set value Yes
Fuel Pressure current value drops below the pre-set value Yes
Battery Voltage current value drops below the pre-set value No
9
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Displaying an Alarm
When an alarm condition occurs, the built-in amber warning light turns on, and the digital
display gives a warning message to show the type of alarm:

Clearing an Alarm
Press Switch 3. ( Switch 2 can also be used.)

Showing the Last Alarm
Press and hold Switch 2

Lap times

The lap time is displayed when triggered by
the infra-red lap time sensor on passing the
lap time beacon.

The most recent lap time is held in display
layer 4. Press Switch 3 to see this display
layer. This display gives you the lap number
and time of the last recorded lap.

Resetting the Lap Time to Zero
Press and hold Switch 1 and then press
Switch 4 to reset the lap count and lap time
to zero.

Gear shift light
The gear shift light comes on when the engine RPM
exceeds a predefined value. See “Configuring the
Display System” for information about setting
this value.

10
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CHAPTER 3. CONFIGURING THE DISPLAY SYSTEM

Configuration mode

You put the Display System into configuration mode by pressing Switches 1 and 2 together.
You then work through the configurable parameters in a pre-set sequence. Press Switch 3 to
display the next configurable parameter. The configurable parameters are displayed in the

following order:

Configurable Parameter

Setting Required

Wheel Circumference

Set a value in the units of measurement indicated

Wheel sensor pulses per revolution (W.S.
PULSES/REV)

Set the value to the number of ferrous targets that the
wheel sensor is to count for each wheel revolution

Engine Speed

Number of cylinders in engine (for RPM)

Minimum RPM for the Pressure and Temperature

Mask RPM warnings to operate

Start at RPM RPM at which the logging option is started
SHIFTLIGHT RPM RPM at which gear shift light is to come on
HIGH WATER Maximum water temperature alarm
HGHOIL T Maximum oil temperature alarm

LOW FUEL P Minimum fuel pressure alarm

HIGH AIRT Maximum air temperature alarm

HIGH GEART Maximum gear temperature alarm
LOWOIL P Minimum oil pressure alarm

LOW BATT Minimum battery voltage alarm

Setting or resetting configuration values

Use Switch 1 to decrease the value being configured and Switch 2 to increase it. The rate at
which the value increases or decreases itself increases while the switch is being held down.

Examples of the displays for each of the configuration items are shown below.
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Wheel circumference:

Engine speed cylinders:

Logging RPM:

High water temperature:

Low fuel pressure:

High air temperature:

Low battery voltage:

Switching Alarms on or off

Wheel speed pulses:

Gate RPM:

Shift RPM:

High oil temperature:

Low oil pressure:

High Gear temperature:

You can enable (switch on) or disable (switch off) each of the alarm warnings by pressing and

holding Switch 1 and then pressing Switch 2.

Note that you might change the pre-set value of the parameter slightly while pressing both
switches. This does not matter if you are switching the alarm warning off and, if necessary,
you can correct the pre-set value after you switch it on again.

12
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Leaving configuration mode
When you wish to return to the normal display, press Switch 4.

Switches

The four switches are used to control the functions of the Display System.

The normal functions of the four switches are:

Switch Functions

Switch 1 1. Show Peak Values
Switch 2 é glﬁ:vrvALEsrTAlarm
swena | e Doy Ly

Warning lights

The Display Module has two built-in warning lights. One of these is the gearshift light and
the other is to warn the driver that an alarm has been triggered.
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CHAPTER 4. PREDICTIVE LAP TIMING SYSTEM (OPTION)

The Predictive Lap Timing System is an upgrade option to the dash, which requires the dash
to be returned to Stack for re-configuration.

When this option is activated the display will have an additional display layer for the driver
to view on the track and will have addition menu items in the set up mode.

Predictive Lap Time Display Layer (Layer 5)

Top Row
® Bestlap time

® Running time from start of lap
® Prediction of next lap time

Bottom Row
® A graphical comparison of the relative Press Switch 3 to change the display back to layer 1

Switch Functions
Additional Configuration Parameters

Switches Functions

1. Clears fastest lap stored by Predictive Lap
Switchl + Switch 4 | Timing System
2. Clears fastest lap from Lap Time Memory

Bar Width
Specifies the time range of the bar graph ei-
ther side of the centre.

The number shown is the time in seconds —
e.g. 0.45 seconds — and can be adjusted to suit driver consistency.

Accel Limit

This value can be adjusted to reduce the ef-
fects of wheels spin. The value represents an
acceleration rate limit in G (M/S?). Under
normal circumstances it can be left as the de-
fault value (10G) but on wet tracks it may be reduced to improve accuracy.

14

© Stack Limited



Dash Logger for Porsche GT3 Stack Sensors

Decel Limit

This value can be adjusted to reduce the ef-
fects of wheels lock up. The value represents
an acceleration rate limit in G (M/S2). Un-
der normal circumstances it can be left as the
default value (10G) but on wet tracks it may be reduced to improve accuracy.

CHAPTER 5. STACK SENSORS

The Stack system takes most of its information directly from the Bosch ecu, however the
following sensors are provided by Stack.

Lap timing sensor
The lap timing sensor is actuated by an infra-red beacon positioned
at the side of the circuit.

This sensor must be positioned horizontally and square to the axis
of the vehicle. In order to detect the signals from the beacon, it
must be sighted outside the vehicle. It should, if possible, be posi-
tioned so that other vehicles that are being overtaken (or are overtak-
ing) at the moment your vehicle passes the beacon do not block the
signal.

Note that after detecting a signal, the system does not recognise any fur-
ther signals from beacons for a period of ten seconds.

Trackside Infra-Red Lap Beacon
The ST544 trackside infra-red lap beacon should be located as follows:

® As near to the start-finish line as possible

® At the same height as the on-vehicle detector

® Level, so that it emits a horizontal beam \

¢ It must be between 2 and 30 meters (6 to
95ft) from the vehicle when the vehicle
passes it.
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Avoid positioning the beacon so that the sun is directly behind it when it is being used.

Where the unit is to be used for lengthy periods in very hot, sunny conditions, it should be
protected by shading it from direct sunlight.

Do not allow water to be sprayed onto the transmitter lenses. During wet conditions, fit a
protective shroud over the beacon.

Power supply to Trackside beacon
The beacon operates from a 12v DC supply. A sealed lead-acid battery with a minimum rat-
ing of 2.5 Amp/hour is recommended. This provides about 15 hours of operation.

The condition of the battery is indicated by the colour of the LED indicator on the front panel
of the unit:

1. Green: The voltage is, at present, adequate for use
2. Red: The voltage is too low (replace the battery).

3. No Colour: Battery exhausted or disconnected.

16
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CHAPTER 6. DATA ACQUISITION EXPANSION OPTIONS

Your system can be upgraded with a range of data acquisition expansion options. These op-
tions and installation recommendations are explained below.

“Track Mapping” Upgrade

Upgrade consists of a G sensor. Simply plugging in this sensor allows you to record Lateral-
G and enables the standard supplied Software to calculate Track maps and provide Corner
Radius analysis.

Installing the G

sensor
The lateral Accelera- ‘
tion connects to a C]]:l—:
ready terminated
connector labelled

“A” on the standard
vehicle wiring harness.

The most suitable place to fit the lateral Acceleration sensor is as close as possible to the vehi-
cle’s centre of gravity.

The sensor must be positioned flat with the label on top and rotated so that the L and R arrow
points to the left and right of the car as the driver sits.

“Driver” Upgrade
Upgrade consists of a G sensor and Software. System provides Track Mapping, Corner Ra-
dius analysis and Throttle analysis.

“Engineer” Upgrade
Upgrade consists of a G sensor, Steering sensor, Linear potentiometers, potentiometer inter-
faces, supplementary sensor harness and Software.

This upgrade also requires the Recorder “R” module supplied with the car to be returned to
Stack for re-configuration.

Provides Track Mapping, Corner Radius Analysis, Steering Analysis, Throttle Analysis and
Analysis of ... Damper Movement, Damper Velocity, Pitch, Roll and Ride Height.

Installing the Steering Sensor
The supplied sensor kit consists of: Rotary Sensor, Pulley, Rubber Band and Mounting Bracket.

This sensor is ready terminated and must be connected to the harness terminated labelled
IISTR”.

© Stack Limited 17
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It is recommended that the steering sensor be installed with the rubber band looped around
the steering column to drive the rotary sensor through the pulley.

To minimise “creep”, and a resulting calibration drift, the steering sensor must be mounted
parallel to the steering column, the band should be looped twice around the steering column
contacting on a clean high friction surface (e.g. abrasive tape).

Installing the supplementary wiring harness
The supplementary wiring harness is designed specifically for the GT3R. The harness should
be installed in the car as shown below.

Installing Damper Sensors
The supplied sensor kit consists of four (4) 100 mm linear potentiometers and four (4) inter-
face modules.

Each linear potentiometer must be connected to an interface module and the interface mod-
ule connected to the appropriate harness connection. i.e. “DFR” = Damper Front Right,
“DRL”= Damper Rear Léft etc.

The photographs illustrated on the following page show the recommended mounting of the
linear potentiometers and interfaces.

18
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Front Dampers — Mounting the Potentiometer (top)

© Stack Limited 19
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Rear Dampers - Positioning the Potentiometer interfaces

20

© Stack Limited



Dash Logger for Porsche GT3 Software Installation

CHAPTER 7. INTRODUCING THE DATA ANALYSIS SOFTWARE

This manual is written to support the Stack Version 6.0 Plus Data Acquisition Software.

The ST800 Data Analysis Software is used to analyse and compare the performance param-
eters logged by one of the range of STACK on-vehicle data logging systems. The perform-
ance parameters that can be charted and analysed depend on the particular STACK Data
Logging System in use. Details are given in the User Guide for each system.

Typical performance parameters that are charted are:
* Engine speed (RPM)

*  Wheel speed

* Pressures

* Temperatures

* Battery voltage

* Laptime

* Lateral G force

* Suspension movement

* Steering wheel movement

The software allows you to download the data recorded by the on-vehicle logging system.
The data is recorded and downloaded as numbered runs in separate sessions, such as prac-
tice sessions and the race itself, which can be stored and retrieved for subsequent analysis
and comparison.

The data from the runs is analysed lap by lap and you can compare the data from different
runs or sessions on the same track.

Installing the software

These instructions should be followed when you are installing Version 6.0 Plus Data Analysis
Software for the first time. They should also be used if you have to re-install the software at
any time.

The Software supplied with your system is designed to work with Windows 98, 95, 3.1 and
DOS. These instructions only cover installation and configuration on Windows 98 & 95 ma-
chines.

© Stack Limited 21
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Your system is supplied with two (2) Software disks labelled Porsche GT3R Analysis Software
disks 1 and 2.

Place Disk 1 in the floppy drive and select the Run option from the Windows Start menu.
Type into the dialogue box

A\ I NSTALL

Press the <enter> key to begin installation.

After a few seconds the following dialogue box will pop up.

[-]1-[ STACK SYSTEM 800 ~-- INSTALL V2.4]

[ [Install Details]----------------- +

Source Drive: [A:\ ]
Destination Drive: [c:\st800 ]
User or Team Name: [ 1

Units

(*) British MPH PSI C Install
() American MPH PSI F

() Metric KPH BAR C Exit

ey

Select “Install” to continue loading.

As installation proceeds, various messages are displayed which is normal. When the first
software disk has been installed, the following message is displayed:

Now remove the disk from the drive, insert Disk 2 and select “Another” and press <enter>.

ST800 Install
Installation successful. If you have
another disk to install put it in the
drive and select ‘Another’ or select
‘Exit’ to return to DOS

Another Exit

22
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Software Installation

Using V6.0 Software with Windows 95 & 98

Installing the Software

From the Windows Desktop screen select: | iflj Startl then select: ﬁ' Ejun

Y 1] i il pop up the Run dia-

Open:

Twpe the name of a program, folder, or document, and
Windows will open it for pou.

"4 install

[STACK System 8188 — INSTALL V6.0d]

[Installation Details]

Source Drive: LAz
Destination Drive: [G:~ST8180~
User or Team Mame:

Units:
€ > Metric kmsh har C Install

(=) British MPH psi C
¢ > American MPH psi F Exit

Tab > to move betueen fields
ows Tl to select Units
Alt+]l to hegin installation
Alt+d to cancel installation
ress Alt+M to change to monochrome

=1 E3

!nstallation_Cquleted. If you have another disk to

install put it in the drive and press Alt+A or press
Alt+X to return to DOS. [ |

Exit

logue box.

Type ‘A:\install.exe’ into the
Open file command line and
click on the OK box to install the
program.

The program will start to in-
stall and after a few seconds an
installation menu will pop up.

Specify the drive and directory
to install Stack software. Note:
Systems with option pack
disks must use the default
drive and directory.

If desired a team name can be
included here which will be
displayed on screen with the
data.

Choose the units the software
is to use from this menu.

Select Install (alt-I) to continue
loading the program with
user preferences.

© Stack Limited
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The program will continue to load and you will be prompted to add the next disk in sequence
when each disk has been successfully installed. Select Exit after the last disk has been in-
stalled.

Important notes:
1. Only install the low fuel pressure software disk if you are running the low fuel pressure
sensor on the vehicle.

2. If you are using an Option Pack, the Option Pack
software disk must be loaded independently and
after the initial installation. Install the Option Pack
disk separately from the Run program.

Arange lcons ¢
Ling up lcons

EEstE!
Easte SHorteut
Undo Copy

- B
Setting up a Shortcut T e M

From the Windows Desktop screen move the mouse ore ound
pointer onto the background and double-click on the Micrasoft Word Document
right-hand mouse button to pop up the desktop menu.

Bitmap Image

Erigfcase

Microsoft Excel wWorkshest
Microsoft PowerPoint Prezentation
Microsoft Office Binder

Other Office Documents. .

Select New from the desktop menu which will pop
up a follow-on menu. Select Shortcut from this menu.

Create Shortcut

Twpe the location and name of the item you want to create
& shotteutta. O, ssarch for the item by dlicking Browss.

This will pop up a shortcut installation box.

Use browse or type the appropriate batch file name (refer
to the floppy disk label) into the Create Shortcut command
line and select Next.

ik [ Nets | cacel |

Select a Title for the Program
Select 3 name for the shortout

Choose a name to appear with the shortcut icon and select
Next.

ISldemu.bal

< Back Mext> Cancel

24
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Software Installation

Select an lcon

Select an icon for the shorteut:

< Back

[ Fnsh | caneel |

Stack

Move the mouse
pointer to the

icon and

double click on

the right-hand

mouse button to

pop

shortcut details.

Setting up Shortcut Properties

Ensure the shortcut properties are set to the following:

Select the shortcut icon and select Finish to install
the shortcut.

Open
Send To 3

Cut
LCopy

Create Shaortcut
LDelete
Rename

Select Properties to pop up

up the the shortcut properties

folder.

After setting all the property folders select OK to exit and save the set up. Double click on the
Stack icon to run the program.

Stdemo_bat Properties [21x]

Genetal | Progiam | Font | Memary | Sereen| Misc |

& Stdemo.bat

Tope: Shattcut to M5-DOS Program
Localior: ~ DESKTOP
Size: 957 bytes (367 byles)

MS-D0S name:  STDEMO™1PIF

Croated 27 March 1998 15,3012

Modfied: 13 November 1998 16.3210

Accessed 13 November 1998

Attrbutes: I feadanil T Hidden
¥ Aghive = [ Sysici

Cancel B

Stdemo._bat Properties 2]x]

Gereral Proaam | Fort | Memar | Screen| Misc |

& B

Cmd ine: |C\5TDEMD BAT

Working: [0

Barchfie: [

Shotteut key: INune

Bun: INmma\ window =l

[ Close on et

Advanced Change lcan.

Select
Advanced to
pop up the
Advanced
- Program
Settings

al icel Al

Stdemo_bat Properties 7] Stdemo.bat Froperties
General| Frogram | Fant  Memory | Screen | Mise | General| Program | Font | Memow | Screen Misc |
~ Convertional o
Iriticl b
ook [ ] emorment e 3] v Bl seien saver T QuickEdit
7 Exclusive mode
™ Protected

Tatel [Auto -

" Expanded [EMS] memory

Tatel [puto -

7 Usss Hia

[ Extended pPMS memoy

"MSQDSV cmade (DPMI)

Tatal, [puto -

T
IVF w/arn if stil active

g
‘ ™ Always suspend

- Idle senisityi o

Low High [ East pasting

[Windows shortoutkeys
I AsTab W CilEse [ AlsFitse [ AlSpace
¥ AlsEse W PitSc [V AlteEnter

[z]]

Cancel il

Cancel Al

[Advan.ed Program Settings

k: C:wINDOWSADESKTOPASTDEMO 1. PIF
IV Prevprt MS-D05 Based programs fom detecting Hindoms
I~ Sughest MS.D0S mode as necessary

ﬁns mode ————————————————————————
i /i e for i S0 e
& ee corenti S0 E S lcontiuuration

) Bpecy e e ME-DB configatn
COINFIE B fo MBI ot

S

AUTEEXEEE AT ar S DS mad=:

=l

Confguratior..

Cancel

~Usag
& Filshieern Initalsize: [Defaut | =
© Window

Stdemo. bat Properties [7]

General| Frogram | Font | Memoy Sereen | isc |

[ Display toolbar

|7 Bestore setings on startup

IV Fast AOM emulation

¥ Dynamic memory allocation

Cancel FEHl)

© Stack Limited
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The installation will continue until the above message is repeated again. This time select exit
to end the installation routine.

PC Configuration

Operating System

Your PC must have a CONFIG.SYS file that contains the following setting as the minimum
value:

FILES=40
A higher value can be used if required. The CONFIG.SYS file is held in the root directory.

Storage
At least 3.5 MB of disk space is needed to install and start running the ST800 Data Analysis
Software. The storage required will thereafter depend on the extent of the track, session, and
run data that is created by using the system. Each Download typically using 0.5Mbytes of
disk space

Memory (RAM)
Your PC must have at least 590KB of free memory to run the ST800 Data Analysis Software.

It is recommended that if possible that you also configure your system to run EMS memory
(see following section).

EMS Memory

The ST800 Data Analysis Software can process a large number of data channels simultane-
ously provided that it has enough memory. With a large number of channels, the memory
required by the software becomes significant. This requirement doubles when comparing
two runs. The software checks whether EMS memory is available and, if there is and it is
large enough, allocates its data buffers in it. This effectively allows you to analyse a greater
number of channels than would be possible otherwise.

Do I need this feature?

If your system can display all the charts with all the data channels you in a normal MS-DOS
or PC DOS environment, you do not need to reconfigure the system memory with EMS. This
is normally only possible if you have more than 600K free.

If, however, you see the error message “VNOM Insufficient memory to continue” and the
chart closes. Or... The speed that the Charts redraw is slow.

Then the EMS memory needs to be available.
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Customising your settings

ST800.INI File

This file is placed in the C:\ST800\ directory of your PC and configures the software for the
correct display mode and for other miscellaneous functions. You can edit this file as follows:
at the C:\ST800\ prompt, type ‘EDIT ST800.INI'

Display Monitors:

The ST800 software can use a variety of displays with different levels of high resolution. The
default display type is IBM VGA with 640x480x16 colours. This is set by a line in the <run>.BAT
file & the ST800.INI file, as follows:

<run>.BAT requires: set fg_display=vgal2
ST800.INI requires: display=vgal2

The complete list of display options follows:

Option Type

HERC Hercules 720x348 Monochrome
EGAMONO IBM EGA 640x350x4 Shades

EGAECD IBM EGA 640x350x16 colour

VGAI12 IBM VGA 640x480x16 colour#
EVGAHIRES Everex EVGA 800x600x16 colour
ORCHIDPROHIRES Orchid Prodesigner VGA 800x600x16 Colour
PARADISEHIRES Paradise VGA 800x600x16 colour
TRIDENTHIRES Trident VGA 800x600x16 colour
VEGAVGAHIRES VIDEO? Vega VGA 800x600x16 colour
VESAOQ, VESA1, VESA2  640x400, 640X480, 800x600x16 colour
VESA5 Vesa 5 VGA 1024x768x16 colour
VESA6A Vesa 06A VGA 800x600x16 colour*
VESA7 Vesa 7 1280x1024x16 colour

# Default setting
* Recommended choice for most large screen lap tops

Note: There must be no spaces between the = and the screen driver name
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Backing up data to other drives
The ST800 software will back up data to the disk drive that you installed the software from.
The drive can be changed. This is set by a line in the ST800.INI file, as follows:

[MENUS00]
archive_dir=B:\

Parallel Port Assignment
If you are planning to use the ST890 Network Interface Adapter on a port that is not LPT1,
you must change the following line to define the correct port:

[NET800]
PORT=1 To set the port to LPT2 for example set: PORT=2

ST800.0RG file

The ST800.ORG file is an original copy of the ST800.INI file. Both files can be found in the
ST800 directory. If for some reason the ST800.INI file has become damaged or erased, the
S5T800.ORG file can be copied to the ST800.INI file. To copy the file, at the DOS prompt, enter
the following:

CD \ST800 [Enter]
COPY ST800.0RG ST800.INI [Enter]
CD \ [Enter]

If the computer asks if you wish to overwrite the existing file, enter Y for yes.
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CHAPTER 8. THE ANALYSIS SOFTWARE IN DETAIL
This section describes how to use the ST800 Data Analysis Software to analyse your logged
data.

Download data.

Display an analysis of the downloaded data for a session.

Compare the data from different laps and different runs.

Monitor the STACK Data Logging System on the vehicle.

Organise and manage downloaded data.

Calibrate sensors.

Main Menu

+[ STACK ST8203 - Menu800 Plus VB. 0] - === === === mmmmmmmm e oo +
|

| File Edit Recorder Display Uils Options System Help
1
i

1
i
| Track: DEMOTRAK  Session: DEMOSESS Run: 1 Set up: DASH2

This Main Menu is displayed
when you first start the ST800
Data Analysis Software.

You use this window for prepar-
ing each session prior to
downloading the data and analys-
ing it.

You can also use it to retrieve data
downloaded from previous ses-
sions from files stored on the PC’s
disk storage.

You can select each of the main functions of the Data Logging System:

Using the Mouse

If you have a mouse, move it to the menu and click. You select a choice in a menu by clicking
on it. To cancel a menu, click the mouse on the background away from the menu.

Using the Keyboard
To use the keyboard to see the choices in a menu, press the left or right arrow keys to move
the highlight across the menu bar to each menu.

When you start the software, the File menu is highlighted, meaning that you can select it.

To see the choices in a menu, press the down-arrow key or Enter key.
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Use the up-arrow or down-arrow key to move the highlight to the choice you want in the
menu.

Press the Enter key to select and activate the highlighted choice.
To cancel a menu, press the Esc key.

File Menu
The File menu contains the following choices:

The use of the options in this menu is described below. The normal sequence of operation is:

1. Select the track. This can be a track that you have used previously or

| Select Session...
a new traCk- | Select Track...

| Select Setup...
. . . . i Select Run... H
2. Select the session. This can be either a new one for which you use |:. .~ .7 ;
. . | Backup Session... |
data that you are about to download from the vehicle or a previous || achive seesion .. |
. . | Restore Session... |
session that you wish to analyse. ! Backup Setups
| Restore Setups
Mve Run. ..

3. Select the setup for the vehicle used in the session. The correct vehicle | |-~
setup must be defined prior to running the Recorder Download func- | - .
tion. The vehicle setup is altered using the Edit->Setup Calibration
function (described later in this section).

The session name will default to the current date in the form yymmadd (for example, “960611”
for June 11th, 1996). This makes subsequent sorting of the sessions into date order straight-
forward. You may then accept this session name or enter a name of your own.

Note: When analysing data recorded on multiple vehicles or on one vehicle with more than
one driver it is recommended that multiple sessions are created with the driver’s initial or the
vehicle’s number identifier at the end of the session name. For example, 990611TW.

When the new session name is complete, press the Enter key. The session name field is
cleared and the track and session names you have selected appear at the bottom of the screen.

(Other) displays a list of other tracks that are available for analysis.

The session names 990527, 990610 and 990611 in the example above, are the names of previ-
ous sessions recorded at the track you have chosen.
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Select Run

Use this choice to select the run
you wish to analyse. For example:
The run notes for the highlighted
run are shown in the lower part
of the window.

Select the run by pressing the En-
ter key or double-clicking the

+[ STACK ST8203 - Menu800 Plus V6. 0] -==--===-===-sscmmeoomeomeo oo
| File Edit Recorder Display Uils Options System Help

+[Sel ect Run Number:]------------ommmmmmm o +
| Run Dat e Tine Duration Laps Fastest Chan |
1 Fri Jun 21 11:35:11 9:52 11 0:46.500 13 ~|

2 Fri Jun 21 12:55:10 1:38 5 0:50.230 13 I}

#

[

[

[

[N

vi

i
IUse this for notes which relate to this run only. [N
tInformation which is the sane for all runs wthin one #)
| session should be kept in the session notes file. [N
I

mouse on it. The list of runs is .

| I This run is a denmonstration run. I
cleared and the run number ap- || ! n
pears at the base of the screen. Lo i

Backup Session T
This option copies all of the data

from the selected session onto a diskette in the floppy disk drive* and can be used to transfer
data from one PC to another. Your original data will not be removed from your PC. Note the
data will be stored in a compressed form as a [Session-name].ZIP file. See Restore Session
below if you need to restore the backup data to the original PC or to a different PC.

Archive Session

This option moves all of the data from the selected session onto a diskette in the floppy disk
drive*. Your original data will be removed from your PC. Note the data will be stored on the
floppy disk in a compressed form as a [Session-name].ZIP file. See Restore Session below if
you need to restore the archived data to the PC.

Restore Session

This option copies the backup or archive data from a diskette in the floppy disk drive* back
to the session from which it originally came or allows you to create a copy of the data on a
different PC. The data will remain on the diskette. All of the data for the runs that were
recorded on the diskette will be updated. Any additional runs in the session which are not
on the diskette remain unchanged.

Backup Setups

This option copies all the setup data and system configuration data onto a diskette in the
floppy disk drive*. Your setup data will not be removed from your PC. See Restore Setups
below if you need to restore the setup and system configuration data from a diskette. This
allow a second PC to be setup in the same way as the PC used to download.

*This drive is set during the installation process and is normally A:
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Restore Setups
This option copies all of the setup and system configuration data on a diskette in the floppy
disk drive* back into the data analysis software from which it originally came. All of the
setup data that is restored from the diskette is updated. Any additional setups in the data
analysis software created after the setups were backed up and hence not on the diskette will
remain unchanged.

Move Run

This option moves a run of data into a different track and session. Normally this is only used
when the data has been accidentally downloaded into the wrong place. When the data is
moved into the new session, it is given the next sequential run number. Thus, if you acciden-
tally move data to the wrong place, moving it back again may not result in it having the same
run number as originally.

Exit...(F10)

You can select this action when you want to end the data analysis program. Alternatively,
you can press F10 to end the program when none of the other menus available on this screen
are being displayed. A confirmation box will ask if you do wish to leave the software; select
Yes to exit or Cancel to continue running the program.

Edit Menu

When you select the Edit menu, the following list of choices appears:

Chart Ranges. ..

Chart Ranges | Setup Gl bration
When you select the Chart Ranges choice, a panel is displayed which ;nDet alNIms T

contains a list of the performance parameters whose chart characteris- | | Track petairs. .

tics can be changed; the contents of that list depend on which level of | | cpy setup to rn... |

software you have installed. L A rkers
i Delete Run... |
The Chart Ranges information is stored with the track details. This al- | *------rree *

lows you to have a different set of characteristics for each track that you
visit saving you the trouble of reconfiguring the Chart Ranges from those used at the previ-
ous track.

R R [Hi stogram Ranges]--------------------- +
The values shown are used to determine the char- | | | o0 emoooooooooo C v (600 ]
- . . D oo . .
acteristics that you wish to see in the charts. | | Engine Speed om # YMn [200 ]
| | CHT EGT or Water F _ H
. | lLateral G G ' Wdth [2.0 11
The Y Min and Y Max values can be reset for each | | itongitutina ¢ © E
. . . . ! ! Conbi ned G G —! Number [20 ]
of the items in the list. By narrowing the range to | | {corner radius 1t i
. . .. | ! Gear Rat U %Max [15 ]
the typical maximum and minimum values you | | isceering deg T ;
. . ! !Throttle % 1 Colour [BLUE ][V]!
would expect for each sensor, you will obtain a | | isake % N |
o« o | |Battery \Y A XK Cancel
more visible graph plot of that aspect of the || =l :
A m e e iioo- +
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vehicle’s performance.

Y Min can be configured with a value greater than Y Max. This will cause the chart to appear
upside down and you can use this to invert the G force or damper movement graphs.

You can change the colour of the chart traces by selecting a colour from the drop-down sub-
menu. If the current colour is shown as FIXED, it cannot be changed.

Once you have set all the characteristics to your preferred values, select the OK box to con-
firm any new values just entered. Selecting Cancel aborts this dialogue box without saving
the new values.

Note — You cannot change the units of measurement in this dialogue box. The only way to do
that is to re-install the software from the master disks.

Histogram Ranges

When you select the Histogram Ranges choice, a panel is displayed which contains a list of
the performance parameters whose histogram characteristics can be changed; the contents
of the list depends on which level of software you have installed.

The Histogram Ranges information is stored with the track details. This allows you to have a
different set of characteristics for each track that you visit saving you the trouble of
reconfiguring the Histogram Ranges from those used at the previous track.

The values shown are used to determine the characteristics that you wish to see in the histo-
grams.

The Y Min and Y Max values can be reset for each of the items in the list. By narrowing the
range to the typical maximum and minimum values you would expect for each sensor, you
will obtain a more detailed histogram of that aspect of the vehicle’s performance.

Y Min can be configured with a value greater than Y Max. This will cause the histogram to
appear upside down and you can use this to invert the G force or damper movement graphs.

The Width value defines the width of the bins used to calculate the histogram bars. In the
example above a Width of 2.0 would create bars of 20 to 22, 22 to 24, etc. These values are
used to calculate the percentage time that the selected logged parameter spent within each
bin.

The Number value defines the number of histogram bars that will be shown on the screen.
The minimum value is 1 and the maximum is only limited by the resolution of the PC screen
being used. In practice the maximum number of bins which can be seen without overlap-
ping is about 40. The histogram always displays two extra bins at the top and bottom of the
screen to show the amount of data that is outside the range of the histogram.
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Note — Changing any one of the above four values may affect the values of the other three
since the software will attempt to create bins of equal width.

The % Max value allows you to set the width of the X axis against which the histogram bars
will be shown. If the bars are longer than this, their values must be read from the tabulated
data to the right of the histogram.

You can change the colour of the histogram bars by selecting a colour from the drop-down
sub-menu. If the current colour is shown as FIXED, it cannot be changed.

Once you have set all the characteristics to your preferred values, select the OK box to con-
firm any new values just entered. Selecting Cancel aborts this dialogue box without saving
the new values.

Note — You cannot change the units of measurement in this dialogue box. The only way to do
that is to re-install the software from the master disks.

Changing Vehicle Setups

If you are using the data logging system on vehicles with different tyre circumferences, it will
be necessary to create multiple SETUP files. This is only required where the change in cir-
cumference is significant, such as from 14” to 15” diameter wheels.

It is not normally necessary to set different tyre circumferences due to normal tyre wear.

Any number of setups can be created using the Edit -> Make New Setup choice and copy
the default setup file to a file with a recognisable name e.g. 14inch, 15inch, etc.

Having created a new setup then use the Edit -> Setup Calibration choice to enter the cor-
rect tyre circumference for that setup.

Important — When using multiple setups, always make sure the correct setup is selected be-
fore downloading a run from the datalogger. Use the File -> Select Setup choice to select the
correct setup.

Setup Calibration
Use this choice to calibrate the software to match the values used by the system installed on
your vehicle. The following panel is displayed:

The list may include items not available with your version of the STACK Data Analysis Soft-
ware installed on your PC.

For the basic system the only Setup Calibration requirement is to set the Wheel Circumfer-
ence to the correct value for your vehicle.
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To enter a new calibration value [ .{ciibrate venicie Plus v6.0 - DASHR] - ---ooooooooooo R
or change an existing one, select | | e aremorence T oo 3
the parameter and either press || gwring 0 4, Sevvalue
<Enter> or click on the Set Value | | |5 fera %6 s . x 3
field. This displays a dialoguebox | | | i 3
containing a field in which you || | 4 e |
enter the value (see Sensor Cali- || . ... - 3
bration section). Press OK to con- | | [lgrerr o1c TemPatelrmmmmmmmmmmmmmmmmemmnee e
firm the new value or Cancel to | | {Gaeis: .
revert to the original value. Do ren Track: Pressure: -
| | Rear Track: Pressure: i i
o Tyres: i :
L L |
| Arrow Keys to Select a Scaling Enter to Calibrate. Use Tab for Next Option |
A mm oo +
Set up calibration for “Track Mapping” data acquisition upgrade systems
The Lateral G sensor should not need regular
re-calibration, however there is often a small off- | ;1 Prate ore tateral @rereommemmmeemmer e =
set due to installation or tolerance on the sen- | | Qurrent vaiue HAT-A eoze |
SOT. | Lateral G offset -0.03 G Set Z |
Using the set up calibration any zero offset can | |
be calibrated out. 3 o Cancel |
i Qose and Discard Changed Val ues i
e m e e e e eiieioaooo- +

Set up calibration for “Engineer” data acquisition upgrade systems
The throttle values are provided from the ecu and can not be calibrated through the Stack

system.

Steering sensor calibration.

With the steering wheel fully to the left, select
the Set L field and press <Enter> or click on it.
Now turn the steering wheel fully to the right
and select the Set F field and press <Enter> or
click on it.

When finished, return to the Calibrate screen
by selecting OK and pressing <Enter> or click-
ing on it. Select Cancel to abort.

+[Calibrate Steering]----------------c--c--ooooooooo +
'

Current val ue STEERI NG -14 % 3
i

90 Degrees Left Value 50 % Set L 3
i

90 Degrees Right Val ue -50 % Set R 3
i

i

i

i

i

[0 Cancel 3

i

i

i

i

Close and Discard Changed Val ues
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Suspension position sensor calibration

The basic purpose of this calibration is to decide which suspension position will be assigned
a Zero value. This position could be with the suspension on full droop or more typically it
could be when the vehicle is stationary (on the setup plates with the driver).

The Current value indicates the sensor travel. The sensor’s lowest position being -50% and
its highest position being +50%.

The current values are the values being transmitted from each of the suspension movement
Sensors.

With the vehicle stationary, to assign the current suspension position a zero value, select the
Set Z field and press <Enter> or click on it. In manual mode you can adjust the individual
values to compensate for individual differences between the sensors. When finished, return
to the Calibrate screen by selecting OK and pressing <Enter> or by clicking on it with the
mouse.

Selecting Cancel discards any changes.

Run Details
This choice allows you to go back
. . . +[Edit Run Details Plus V6.0 - RUNOOI]---------mmmmmmmmmm oo +
and modify the setup calibration | srarameter]--------oo---ooomo 200 (Val ue]------- : ;
. I 1 Weel Grcunference 880 mm H H
used for a previous run and also | imrecere LT ISt Value... |
! ISteering ! !
to create and store your ownnotes || ierake Position ... 4 :
| 1Zero Lateral G -0.03 G i XK H
and comments about a run. Do ; :
Do ' cancel |
The Setup Calibration screenis |: ¢ J i
copied into the run details when | { {rn set -y DA - i
you download from the recorder. | i iGrb: Dot l |
! !iChassis: Rocket ! i
1 1 Gear: 90 i i
LR Track: 20 P D21 ! !
Select the run and press Enter. D irear Track 2 Pressurer 21 | |
1 1 Tyres: New Slicks H H
.. | | Bunper: Rubber H H
Any existing notes for the run are | iBolts: K ;
displayed_ Y()u can add further L Arrow Keys to Select a Scaling Enter to Calibrate. Use Tab for Next Option i+
notes and change or delete exist-

ing ones. The use of the editor for
entering and changing the information in a Notes window is given earlier in this chapter.
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Session Notes
Use this option to manually add session notes.

Editor Functions

The Session Notes editor has the following standard function keys:

F2 Save

F3 Save As

F5 Mark

F6 Cut

F7 Copy

F8 Paste

F9 Abort

F10 Exit

Esc Abort

Saves the text you enter. You can use this function to save your text without
closing this window.

Saves the text as a new file. You are prompted for the name of this file. The file
can only be created within the data analysis system. Do not attempt to create
this file on any other path or disk drive.

You can mark any text that you want to cut or copy into another part of the
Notes text. Position the cursor at the start of the text to be cut or copied. Press
F5. Move the cursor to the end of the text to be cut or copied. The marked text
is highlighted. You can now use the F6 or F7 keys to cut or copy the marked text.
You can also use the Del key to delete the marked text.

Press the F5 key to remove the highlight from marked text that you do not want
to cut or copy.

Use this key to cut marked text. The text is removed and retained in a buffer
until you next use the F6 or F7 keys.

Use this key to copy marked text. The text is copied and retained in a buffer
until you next use the F6 or F7 keys.

Use this key to insert text previously cut or copied from a different part of the
Notes text. You can paste the same text as many times as you require.

Use this key to end your notes editing session without saving any changes to
the text since you started the notes session or since you last used F2 to save the
changes.

Use this key to end your notes editing session. Any changes to the text since
you started the notes session or since you last used F2 to save the changes are
saved automatically.

Same as F9 Abort.
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Track Details
Use this choice to define the nominal length of the track

. R [Track Details]---------------- +
and a tolerance for the software to use when it calculates | { —
the length of each lap. | Lengtn [832. 10 Jinetres ][v]
| Tol erance [48.76 J[netres ][v]

. . . i Not
Note — This calculation occurs automatically after data | | e this to store i nformtion about

the track.

download, therefore it is important to enter the correct | | -

This is a denonstration track.

track length prior to data download. -

If the track length has changed since your last visit to the o Cancel ‘
track, you are advised to redefine the nominal length in | oo '
this panel.

You should set the nominal track length to the value that you calculate during practice that is
based on a lap that has provided clean data.

In particular, you should choose a lap in which the line of the vehicle is “good” and which
does not contain excessive wheel lock-up, understeer or oversteer.

The easiest method to determine the Track Length is to set a Length of zero and run the
DISTANCE or STANDARD calculation on the downloaded data. An error box will appear
which shows the exact distances travelled for each lap in the run. The nominal Track Length
is a length that is an average of the displayed lap distances; the Tolerance is the smallest
distance that covers most of the laps.

Set the appropriate units of measurement (feet, metres, kilometres or miles) from the drop-
down sub-menu and then enter the value.

If the data for the run has already been downloaded from the vehicle, it is essential that you
recalculate the normalised* lap lengths for the run. Use the Calculate choice (for Distance) in
the Options menu to do this for every run after you have reset the nominal track length.

Refer to the Editor Functions section for details about the function keys available when work-
ing with notes. You can also use this panel to record the notes about the currently selected
track.

Copy Setup to Run
You can use this choice to copy calibration information stored in the current setup to the run
you select.

* The system attempts to adjust the data for all laps in a run to the same length so that overlaid comparisons are
always perfectly aligned. This process is called normalisation. However, laps whose lengths are outside the
tolerance set for the track will not be normalised.
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Normally this information is transferred immediately after the data is downloaded. It de-
fines how the ST800 software should scale and present the data in the channels.

You are prompted with the Update Run from Setup dialogue box that asks you to confirm
overwriting the calibration values in the current run with those from the current setup. This
might be necessary if the sensors have to be re-calibrated, the wrong setup file was used
during download or because the data is old and contains no scaling values. Select OK to
proceed or Cancel to abort without changing.

Make New Setup

Use the Make New Setup choice to define a new setup for a vehicle.

You are prompted for the name of the new setup. Type in the new name and press the Enter
key. The current setup file is copied into the new setup. Its name is shown on the bottom line
of the screen.

You can now modify the values in the new setup to the values you require using Edit=>Setup
Calibration.

Run Markers

Use this choice to check your lap time data after you have downloaded a
run. You are prompted for a run. An example of a set of lap times that | jt# mn mss.tte
are displayed when you select this choice follows: Lap

Each line shows a time recorded during the run. The first column shows
the lap marker type. The lap marker types are:

OUT  First lap recorded in the run. iLep 1 5. 610

ap
LAP  Any lap except the IN and OUT laps. o et
IN Last lap recorded in the run. SO :

RUN Total of the IN, OUT and all the Lap times.

The second column shows the lap or segment number. The third column shows the time
recorded for the lap in the form minutes:seconds.milliseconds. The final RUN line shows the
time for the whole run.

Warning — It is possible to edit the run markers in this window but this should only be done
if the lap times are very wrong, e.g., some laps are twice as long as others. Entering incorrect
lap times will cause problems when displaying that data. You must also take care to keep the
spacing and number formatting exactly the same as the existing entries. See the Editor Func-
tions section for details of how to edit data.
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Delete Run
This choice lets you remove a run that is no longer required.

Warning — This function cannot be undone so be sure to make backup copies of any runs you
may need again in the future.

Recorder Menu

Note: Before you use any of the choices in this menu for the first time, be sure to connect the
PC to the Data Logging System with the STACK Network cable supplied with this software
before you select this choice. This enables automatic configuration of the software for the
external interface on your PC to the on-vehicle recorder.

The Recorder menu contains the following choices:

Download, Display Run
Use this to download all runs stored in the recorder. If downloading
is successful, the data is erased from the recorder, leaving it ready for | | towioas, oispiay rn 2

. . i Downl oad, Erase Menory
the next run, and the chart for the downloaded run is displayed. If | | bowioad, save nemory
. . . |  Erase Menory
downloading is not successful, the data is not erased from the re- || start Logging
| Stop Loggi n
corder. ! SetpRecg?dl ?19 Ti me

You can select this function before you connect the PC to the recorder.
When the connection is detected the data will be downloaded.

You may disconnect the PC from the recorder as soon as downloading is complete.

Once downloaded the software performs a variety of calculations on the data and then the
run is displayed. If more than one run is downloaded the latest one is displayed.

Download, Erase Memory

Use this choice to download the data from the vehicle after a run has been completed. The
data is removed from the storage on the vehicle’s system. The data is not displayed on the
PC; it is stored as a run for later analysis.

This choice waits until you connect the PC to the recorder if you select it before connecting. It
downloads all runs stored in the recorder and, upon successful completion of downloading,
erases the data from the recorder, leaving it ready for another outing. If the downloading
operation is not completed successfully, the data is not erased from the recorder.

Disconnect the PC from the recorder as soon as downloading is complete.
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Download, Save Memory

Use this choice to download the data from the data logger on your vehicle after a run has
been completed. The data is not removed from the data logger on the vehicle. The data is
not displayed on the PC; it is stored as a run for later analysis.

This option will wait until the PC is connected to the recorder. It downloads data for all runs
present in the recorder but does not erase it from the recorder. Use this choice when you
need to download the data in the recorder into more than one PC.

Disconnect the PC from the recorder as soon as downloading is complete.

Erase Memory
Use this choice to remove any unwanted data present in the on-vehicle recording system
and reset it, leaving it ready for the next outing.

Start Logging

Use this action to start logging data directly from vehicle.

Stop Logging
Use this action to stop logging data directly from the vehicle.

Display Menu
The Display menu contains three +[STACK STB204 - MenUBOO Pl US VB. 0] -----=-=-==nn-mnmmmmmmmmommomoaaoooos +
1 ] 1 VRl Edit Re di Di spl Wil t Syst Hel
choices each with its own sub- | | fi'e &t Recorder Display Uils options system telp
menu of four choices: i { Chart i Single...
| | port -1 Conpare...
i Hi st ogram -1 Quick Single
! FERROFRRERRREERE | Qick @ :
Note that you must select the | AV A IR

track and session before using the
display options. You do this us-
ing the File=>Select Track or
File=>Select Session facilities.

Chart

Displays a strip-chart showing the | Track: DENOTRAC _ Session DSHCEESS R P PSR '

values logged during a run for the
track and session that you selected earlier.

Report
Displays a segment-based report for the logged data as Chart.

Histogram
Displays a histogram for the logged data as Chart.
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Single Sub-menus

Displays the chart, report or histogram for a single run showing the same channel selection
that you chose when you last displayed the chart. You will be prompted to select the run
from a list of runs for the selected session.

Compare Sub-menus

Displays a chart, report or histogram comparing the values from two runs. You will be
prompted to select the two runs to be compared and the session in which the reference run
occurs.

Quick Single Sub-menus
Displays a chart, report or histogram showing the data logged for the currently selected run.

Quick Compare Sub-menus
Displays a chart, report or histogram showing a comparison between the last two selected
runs.

Utils Menu
Real Time Display

Use this choice when the system is connected to the vehicle to monitor the sensor values
from the logger. The values displayed are determined by the calibration values contained
within the setup. Ensure that all of the vehicle sensors have been calibrated prior to using the
Real Time Display option in order to the correct values.

Configure Network
Use this choice the first time you connect the PC to the on-vehicle system. Its purpose is to
enable the software to configure itself for the computer on which it is running,.

Important — You must do this before attempting to download any data from the on-vehicle
system.

System Diagnostics

In the event of a system malfunction, this choice allows the user (under guidance from Stacks
service personnel) to interact directly with the systems internal control software in order to
identify operational problems.

Important — Incorrect use of this feature can cause system corruption and the loss of valuable
recorded data.
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Options Menu
This menu contains the Calculate and Select Track Map choices. These choices are not used
on systems restricted to time-based analysis of performance data.

Calculate
This choice allows you to calculate various parameters for runs in the currently selected ses-
sion. These include Distance, Calculated channels and Track Maps.

Select Track Map
This choice allows you to select the Track Map to be used on the Chart and Report Displays.

System Menu

Screen Mode
This switches the menu display between white-on-black and black-on-white modes.

Shell to DOS

Select this choice when you wish to suspend the software and run another program.

This function gives you access to the operating system prompt without ending the session.
You can use the operating system prompt if you need to run any utility programs or issue any
MS-DOS commands to delete; copy or move files and generally maintain your system.

You return to the session by entering the Exit command at the MS-DOS prompt.

Help Menu

Index
The Index choice displays a list of entries which additional detailed on-line help information
is provided. Highlight the topic of your choice to see the help information.

About

This choice displays information about the ST800 Data Analysis Software and the operating
environment in which you are currently using it.

Press the Enter key to return to the menu screen.

Using Chart
The following example of the data charting window shows values logged for each of the
parameters plotted for a lap, graphed against time.

The map of the track shows the location of the vehicle at the cursor position on the chart.

Note: the circuit map is not available in the ST8101 and ST8201 Data Logging Systems.
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Each of the logged parameter values are displayed as lines plotted on a graph and as numeric
values for the cursor position. You can move the cursor to any position on the track during
the run.

You can zoom into any particular section of the display for a run to see it in greater detail.
You can overlay data from other runs and compare the differences in the data values or show
the differences as a graphed line. Where the data logging system records wheel speed, dis-
tance based comparisons can be made.

You can select each of the menus by clicking on it with the mouse or press Alt plus the high-
lighted key. Click on the chart or Press the Esc key to cancel a menu and return to the chart if
you decide not to use any of its choices.

Any changes made to the runs and lap selected or the display colours in the Chart are re-
flected in the Report and Histogram displays when they are next run.

The headings below show the menu choices and their hot key alternatives.

Files Menu

Select Run (Ctrl+F3)
Use this choice to display a different run. Select the run from the list of available runs.

Exit (F10)
Use this to close the chart window and return to the menu system.

Reference Menu

This menu provides a set of choices that allow you to manipulate the reference run. The
choices are:

Select Run (Ctrl+F4)
Use this choice to use a different reference run.

Select Lap (F4)

The Select Lap menu presents a list of the laps in the reference run being displayed. The
reference lap being displayed is shown highlighted. The Fastest Lap is marked with a>. You
can display any of the laps in the list by selecting it and pressing <Enter> or clicking on it.

Lap menu presents a list of the laps in the reference run being displayed. The reference lap
being displayed is shown highlighted. The Fastest Lap is marked with a >. You can display
any of the laps in the list by selecting it and pressing <Enter> or clicking on it.
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STACK ChartB888 Plus VUt .Bb DEMOTRAK All Chanmnels

Files Reference

Move Chart Reports HNote Help F1 A4 #»

WSFD S0

=tesr m

Ceg ]
[f=Et 12
i 18
Cath 2.@;
G 0.0
=z,
Long -]
5 EI.EI—_
=1, 0
TIME LA I L N AL P A B R B
SECONDS i@ 15 0 25 30 a5 40 45
# DEMOSESS = | YSPD 46.8 Long B.85 Water 78
RUN 2 4:59 | ESPD18A8Z ConG 1.29 Gear 214
Throt 84 CHT 196 Dist 4287
Iy A:23.238
os LatG-8.86 | EGT _ 398

Set Reference Offset

align a section.

To realign the runs start by positioning the cursor on the reference trace (dark colour) and
select a region from there to the equivalent position on the current trace (light colour). Then
select the menu option or press Ctrl-O and the runs will be realigned. If the alignment be-

(Ctrl+O0)
This function is used to align the runs when you are comparing data which has the laptimer
beacon in a different location or when you are operating in time-based mode and need to

comes worse, select the traces in the reverse order.
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Move Menu
The Move menu provides a set of choices that allow you to change your view of the run
being displayed. The choices are:

Select Lap (F3)

The Lap menu presents a list of the laps in the run being displayed. The current lap being
displayed is shown highlighted. The Fastest Lap is marked with a >. You can display any of
the laps in the list by selecting it and pressing <Enter> or clicking on it.

Fastest Lap
Displays the fastest lap in the run.

Previous/Next Lap (Ctrl+J, Ctrl+K)
Displays the lap before or the lap after the current lap.

Zoom In/Zoom Out (1, 1)
Use these to see the chart in more or less detail.

Zoom sequence Run=> Lap=> Selected section.

Zoom Run
Zooms to show the full run across the screen.

Scroll Left/Scroll Right (Home, End)
Use these to pan the view half a screen width towards the start of the run (left) or the end of
the run (right).

Warning — This command scrolls both the reference run and the Current run. Doing so can
result in the displayed reference data not being that selected for the reference lap. Always
use Previous Lap or Next Lap if you wish to keep the same reference lap.

Jump Left/Jump Right (Ctrl+Home, Ctrl+End)

Use these to pan the view a whole screen to the left or right (as for scroll).

To Run Start / To Run Finish

Use these to move to the start or end of the run. Run Start moves the view to the start of the
Out lap. Run Finish moves the view to the end of the In lap.
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Chart Menu

The Chart menu contains the following choices:

Select (F2)
This lists the choices of chart available with the version of the ST800 Data Analysis software
you are using.

Layer (Ctrl+T)

This allows you to switch the view between the current run and the reference run.

Line type  (Ctrl+L)
This allows you to select the type of line for charting the recorded values: these can be Sum-
mary, Real or Point.

Grid type  (Ctrl+G)
This allows you to define the type of grid for the chart. These can be Lines, Dots or None.

Colours (Ctrl+M)

This choice changes the colour schemes used for the chart.

Refresh Chart (Ctrl+W)

Causes a complete redisplay of the chart screen.

Reports (F5)
Displays a statistical report calculated for the currently displayed zoom or the selected re-
gion.

Notes
Displays the run notes for the current run and the reference run in a scrollable window.

Current Session demosess  Run i

+
Use this for motes which Felate to this Fun ohly.
Information which iS the Same for all runs within one
Session

should be kept in the session notes File.

This rJn 5 2 deMohsStration Fun.

Refetence Session DEMOSESE Ruh 2

Use this for nobtes which relate to this run onld.
Information which iS the same for all Funs within one
=ession

Should b2 kept ik the Session notes file.

This run is & demonstration run.
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Help (F1)

Displays the help text in a scrollable window.

<<

Scrolls the current run backwards one lap. The reference is not affected. The same function
is available with the (,) key or from the Move=>Previous Lap menu choice.

>>

Scrolls the current run forward one lap. The reference is not affected. The same function is
available with the (.) key or from the Move=>Next Lap menu choice.

Using Report

The Report display is not available in the ST8101 and ST8201 Data Logging Systems.

The map-based report generator has an interactive map display showing segments, a set of
value boxes showing the value on each channel at the cursor position and a report window.

The report window can show a Statistics report, a Segment Compare report or a Segmented
Run report.

Segments can be added or deleted at any time. They are stored along with the track in the
track directory.

The cursor position is shown on the map with a diagonal cross. The cursor can be moved by
clicking on a new position with the mouse or with the left-arrow and right-arrow keys.

The corner segments are numbered sequentially starting at the laptime beacon. Corners are
shown in black and straights are white. The beacon position is a blue triangle pointing in the
direction of travel.

Any changes made to the runs and lap selected or the display colours in the Report are re-
flected in the Chart and Histogram displays when they are next run.

Note — It is not valid to compare data recorded with different beacon locations using the
report program since it has no lap realignment facility.
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Software Description

Statistics Report

The Statistics Report shows the statistics calculated for the whole of the current lap. It is not

possible to display statistics for the reference lap.

An example report is shown below:

STACK ReporiB8AA Plus V6.8b DEMOTRAK

Files Reference Move Edit BReports HNotes Help F1 A4 b
Time from: 45Z.2%0 to: 525,730 46,500 secs
G Charnel Min  Max  Awve Start End Diff Raters
W2FD 31.7 556.8 4d.3 47.85 45.7 -0.7 -0.015
ESFD 6214 11556 3555 10254 10055 -—-155 —4.000
Steer -1z 2% 3 1 z 1 .02z
Throt 4 18® &1 8% 86 -3 -0.06%5
L3tE 1,93 2,36 -0.07 @.36 0.26 -9.10 -0.002
Lona -@.31 0.27 0.0 @.87 0.05 -0.01 -0.000
ComG @.@E Z.37 @.53% ©0.11 0.15 @0.87 Q.08z
Batt 10,5 18.6 18.5 10.6 18.5 -0.1 —@.082
CHT 135 285 281 203 202 -1 -@.02Z
EGT 334 398 39s 34 396 2 .043
Watar 3 53 =inl [=4 51 -1 -Q.@=F
Gear 152 241 215 214 Z14 @ Q.002
Rad 13 65535 1954 65535 915 64617 -1330.
Dist 3271 18196 5743 3271 19136 325 13,59
+
= DEMOSESS = DEMOSESS WSPD 47.6 _48.1 8.5 Long A.A9 A.12 -A.83
RUN 1 9:52 RUN 2 4:59 | ESFD 18254 18383 -54 ConG .11 A8.29 -8.18
Lii ©#:46.588 L. 5 @:46.4608 Steer 1 4 -3 Batt 18.6  18.4 A.z2
P 0:66.688 P d:08 . BEe Throt g9 BY 2 CHT 283 198 5
os  H-HE os  H-Ed LatG  ©.36 @.17 9.19 | EGT 394 394 8
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Segment Compare Report

The Segment Compare Report shows the speeds and times for each segment for the current
lap compared against the reference lap. This report cannot be displayed when a single run is
being shown.

An example report is shown below:

STACK ReportiB8AA Flus V6.8Bh DEMOTRAK

Filez Reference Move Edit Reports Help F1 <44 k@

Segment Compare
Cur DEMOSESS Run 1 Lap 11  44.58MFH  @:d6.50s
Fef DEMOSESS Run 2 Lap 5 44.54MFH  @:de6.d6s
Di fFatence —@. @4MFH 0.045
speeds 3plit Times
Segment. cur Ref i cur Ref Diff

Motes

—@.1@
@@

+*
= DEMOSESS = DEMOSESS WSPD  47.6 48.1 8.5 | Long ©.A9 A.12 —A.83
RUN 1 9:52 RUN 2 4:co | ESPD _1A254 1A388 54 | ComG__ B.11 A.29 —A.18
o N e e 1 4 -3 | Batt 19.6 18.4 8.2
5 B:6D. 608 P p:00 apg —rot 89 87 2 | cHT 783 198 5
o= H-HE- o= H-Hd- LatG ©.36 8.17 ©.19 | EGT 394 394 8
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Segmented Run Report
The Segmented Run Report shows the times for each segment for every lap in the current
run. Itis not possible to display this report for the reference run.

The fastest segments in the run a surrounded with brackets and these are repeated in the
Theoretical Fastest Lap row below. Furthermore, the Fastest Rolling Lap is also shown

An example report is shown below:

STACK ReportB8AA Flus V6.8h DEMOTRAK

Filez Reference Move Edit Reports MHotes Help F1 <44 »r

Begmented Run

Lap Total 3-1 1 1-2 = -3 3 3-4 4 =3 -6 -] &-F n
1 T@.23 @.&6% 4.3% S5.5% 4.@1 T.PF Z.2% 2,17 T.2% 4,50 £.E0 .65 I1.@% .
Z 47.45 @446 F. 41 4.851 I.TF1 TG (Z.10) 1,95 4092 4,52 6.71 F.Td4 F.1T

3 456.56 @.46 3,33 4.8@8 I.7@ (V.87 Z.27 1.98 4.85 {4.37) £.5% 3.47 I 11

4 45,98 (@.46) 3.356 4.7@ (I.5T) S5.01 Z2.135 (1.55) 4.87 4.62 E.82 3.45 (3.7

S d46.46 @.45 (3.3 4.7@) I.E4 T.FE Z.1d 1.5%@ (4.33) 4,43 (5,54 3.dd) .83

Fastest Rolling Lap

4 4. 44 .87

@.46 3.3 4.7@ F.64 V.5 Z.14 1.@3 4.53 4.43F &6.54 F.d4
Theoretical Fastest Lap
46.13 @.46 3.3Z 4.7@ 3I.37 V.57 Z.10 1.55 4.53 4.37 6.34 3.44 3I.@7

«| | *

» DEMOSESS » | WSPD 48.1 | Long 8.12 | Water 79
RUN 2 4:59 | ESPD1A388 | ComG B.29 | Gear 214
Steer 4 | Batt 18.4 | Rad 964
Throt 87 | CHT 198 | Dist 3788
LatG .17 | EGT 394

LS5 B8:46.468
Pos 0A:88.888
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Files Menu

Select Run (Ctrl+F3)
Use this choice to display a different run. Select the run from the list of available runs.

Exit (F10)
Use this to close the report window and return to the menu system.

Reference Menu

Select Run (Ctrl+F4)
Use this choice to select a different reference run.

Select Lap (F4)

The Select Lap menu presents a list of the laps in the reference run being displayed. The
reference lap being displayed is shown highlighted. The Fastest Lap is marked with a>. You
can display any of the laps in the list by selecting it and pressing <Enter=> or clicking on it.

Lap menu presents a list of the laps in the reference run being displayed. The reference lap
being displayed is shown highlighted. The Fastest Lap is marked with a >. You can display
any of the laps in the list by selecting it and pressing <Enter> or clicking on it.

Move Menu
The Move menu provides a set of choices that allow you to change your view of the run
being displayed. The choices are:

Select Lap (F3)

The Lap menu presents a list of the laps in the run being displayed. The current lap being
displayed is shown highlighted. The Fastest Lap is marked with a >. You can display any of
the laps in the list by selecting it and pressing <Enter= or clicking on it.

Fastest Lap
Zooms to the fastest lap in the run.

Previous/Next Lap (Ctrl+J, Ctrl+K)
Moves to the previous or next laps.
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Edit Menu
The Edit menu contains the following choices:

Insert Segment (Insert, Ins)
This adds a segment to the map. Highlight an area using the mouse or the shift-cursor keys
and then press the Insert key or select Insert Segment from the menu.

Delete Segment  (Delete, Del)
Deletes a segment from the map. Move the cursor into a corner segment using the mouse or
the cursor keys and then select Delete Segment from the menu.

Colours (Ctrl+M)
This choice changes the colours used for the report.

Reports Menu
This menu contains the following choice:

Statistics  (F5)
The values displayed are calculated for the currently displayed lap and not for the selected
region.

Segment Compare
Displays segment time and speed comparison chart for the selected and reference laps.

Segmented Run

Displays a table of the segment times for each lap over the entire run with the fastest segment
times enclosed in brackets. At the base of the table are two lines showing the segment times
for the fastest rolling lap and the fastest theoretical lap which is made up of all the fastest
segment times.

Notes
Displays the run notes for the current run and the reference run in a scrollable window.

Help (F1)
Displays the help text in a scrollable window.

<<
Scrolls back one lap. The same function is available with the (,) key or from Move== Previ-
ous Lap menu choice.

>>

Scrolls forward one lap. The same function is available with the (.) key or from the
Move==Next Lap menu choice. 53
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Using Histogram

The following example of the histogram window shows values logged for the wheel speed
parameter plotted against time for one lap in the current run compared with a lap from the
reference run.

ACK HISTOGRAM 888 Flus V6.AL DEMOTRAK Wheel Speed vs Timne

Filezs Reference MHove Histogram MHotes Help F1 A4 kb

T T.0%  ©.0%  ©0.0%
@@ @, @x% @@
z: @. 2% 1.9% -1.7%
sS4 3.9% d.7H  —-D.FR
v S.6% G TH 1.9%
sa S.68% 11.6% -Z.0%
45 17.6%8 16.1% 1.5%
11.6% 1@.3% 1.3%
:i G.9% G.TH @. 2%
a4z S.8% 4. 3% 1.5%
EH o S.6%  4.5%  1.1%
s S.dx S.8% -0.4%
35 S.6% . TH 1.3%
34 S.0K 10.1% -1.1%
3z 3.9 3.4% @ 4%
e 1.5% Z.84 —-1.3%
o @@ 1.3 —-1.3%
o @@ @, @x% @@
. @@ @@ @@
=5 @@ @@ @@
@.@x @.@x @.@x
e Lr P} D0 Lr P}
i S S S S S S R L1
» DEMOSESS =  DEMOSESS | WSPD__ 45.8 46.8 -1.8
RUN 1 9:52 RUN 2 4:59 | ESPD 1378 18@82 296
L11 B:46.580 L 5 8:46.468 ?EBE: ;2 32 13
0 0 ro =
Pos B:23.258 Pos B:23.268 U ——————C

The map of the track shows the current location of the vehicle.

The width of each bar represents the percentage of the time for the selected lap for which the
parameter was within the bins defined for that parameter. The box to the right show those
times as columns of data. Numeric values are shown below the histogram for the current
cursor position on the map. You can move the cursor to any position in the current lap.

You can zoom into any particular section of a lap to see it in greater detail. You can overlay
data from other runs and compare the differences in the data values.
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You can select each of the menus by clicking on it with the mouse or press Alt plus the high-
lighted key. Click on the histogram or press the Esc key to cancel a menu if you decide not to
use any of its choices.

Any changes made to the runs and lap selected or the display colours in the Histogram are
reflected in the Chart and Report displays when they are next run.

The headings below show the menu choices and their hot key alternatives.

Files Menu
Select Run (Ctrl+F3)

Use this choice to display a different run. Select the run from the list of available runs.

Exit (F10)

Use this to close the histogram window and return to the menu system.

Reference Menu
This menu provides a set of choices that allow you to manipulate the reference run. The
choices are:

Select Run (Ctrl+F4)

Use this choice to use a different reference run.

Select Lap (F4)

The Select Lap menu presents a list of the laps in the reference run being displayed. The
reference lap being displayed is shown highlighted. The Fastest Lap is marked witha >. You
can display any of the laps in the list by selecting it and pressing <Enter> or clicking on it.

Move Menu
The Move menu provides a set of choices that allow you to change your view of the run
being displayed. The choices are:

Select Lap (F3)

The Lap menu presents a list of the laps in the run being displayed. The current lap being
displayed is shown highlighted. The Fastest Lap is marked with a >. You can display any of
the laps in the list by selecting it and pressing <Enter> or clicking on it.

Fastest Lap
Displays the fastest lap in the run.

Previous/Next Lap (Ctrl+J, Ctrl+K)
Displays the lap before or the lap after the current lap.
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Zoom In/Zoom Out (1, 1)
Use these to zoom in to a area of the lap selected on the map or to zoom out to show the
whole run.

Zoom sequence Run=> Lap=> Selected section.

Zoom Run
Zooms to show a histogram of all the data the full run.

Histogram Menu
The Histogram menu contains the following choices:

Select (F2)

This lists the choices of histogram available with the version of the ST800 Data Analysis soft-
ware you are using.

Bar type (Ctrl+L)
This allows you to select the type of bars to be used to display the histogram. These can be
Open, Closed or Filled.

Grid type  (Ctrl+G)
This allows you to define the type of grid for the histogram. These can be Lines, Dots or
None.

Colours (Ctrl+M)

This choice changes the colour schemes used for the histogram.

Refresh Histogram (Ctrl+W)

Causes a complete redisplay of the histogram screen.

Notes
Displays the run notes for the current run and the reference run in a scrollable window.

Help (F1)
Displays the help text in a scrollable window.

<<

Scrolls the current run backwards one lap. The reference is not affected. The same function
is available with the (,) key or from the Move=>Previous Lap menu choice.

>>

Scrolls the current run forward one lap. The reference is not affected. The same function is
available with the (.) key or from the Move=>Next Lap menu choice.
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Printing data
To print Charts, Reports & Histograms it is recommended that you purchase “Printscreen 95
v4.0”from Super Simple Software, Los Angeles, CA, USA.

E mail: glencj@sssware.com
http://printscreen95.com

Tel:  ++(1) 310 839 9543
Fax:  ++(1) 310 839 9280
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Dash Logger for Porsche GT3

CHAPTER 9. TROUBLESHOOQOTING
Display System problems

No. | Symptom Possible Cause Remedy Notes
Ignition is off Turn ignition on
Display is dead
(no backlight, nothing Battery is dead Reclhargg (;tr
1 |ondisplay, no green fepiace batery
dial lights) Check if battery is
Power connection | connected correctly.
to B+ or B- is faulty | Check power lead
continuity
Display is dead (no _
backlight, nothing on Battery is almost Recharge or
display, green dial dead replace battery
o |lights on but dim)
or .
Power connection [ Check power lead
! I._0W BATT " is faulty continuity
warning on display
Battery is almost Recharge or
Display flashes andd dead replace battery
3 | dial pointer resets or
vibrates Power connection | Check power lead
is faulty continuity
If you have just changed
. Dash is not . or re-programmed the
4 Display values do not receiving data from Check_ ponnecnons ECU check correct ECU
update and wiring to EC Co
ECU protocol is being
transmitted
58
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Troubleshooting

No. |Symptom Possible Cause Remedy Notes
Pressure sensor Replace sensor
has failed P
The " LOWOIL P ! . Check that the oil
Qil pressure alarm ;
5 message does NOT . pressure alarm is
disabled
appear on power up. seton
Check power to
ECU not powered ECU
. Incorrect values Check ECU
Displayed values are : . .
6 incorect being transmitted protocol being
by the ECU transmitted
Peak values only
Gate value set too ihtz;\]r;gce“fall;e RPM updated while the engine
high " t? y RPM is greater than the
7 Peak values not contiguration Ment | te value
updated
ntemal memo Return unit to Stack | Display shows
i for new battery I' MEM BATT ! warning
battery dead .
service on power up
Disconnect switch and
) . short its leads. If display
8 Switch 1 Show peak Switch 1 faulty Replace switch changes, replace Switch
values does not work )
1. Otherwise check
wiring.
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No.

Symptom

Possible Cause

Remedy

Notes

Switch 1: Show peak
values does not work

Faulty switch wiring

Check switch wiring
for correct continuity

Pin K to red S1 wire less
than 1.0 Ohm and Pin K
to Pin H (earth) greater
than 1M Ohms)

10

Switch 2: Show last
alarm function does not
work

Switch 2 faulty

Replace switch

Disconnect switch and
short its leads. If display
changes, replace Switch
2. Otherwise check
wiring.

Faulty switch wiring

Check switch wiring
for correct
continuity.

Pin L to red S2 wire less
than 1.0 Ohm and Pin L
to Pin H (earth) greater
than 1M Ohms)

1

Switch 3: Change
display layer function
does not work

Switch 3 faulty

Replace switch

Disconnect switch and
short its leads. If display
changes, replace Switch
3. Otherwise check
wiring.

Faulty switch wiring

Check switch wiring
for correct
continuity.

Pin U to orange S3 wire
less than 1.0 Ohm and
Pin U to Pin H (earth)
greater than 1M Ohms)
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Troubleshooting

receiver lead faulty

wiring

No. | Symptom Possible Cause Remedy Notes
Disconnect the switch
and short the leads
. . together. If the display
Switph 4 does not set | Switch 4 faulty Replace switch changes replace Switch
or display pop-up lap 4, Otherwise check
12 times when no wiring.
automatic receiver in ) .
use Check switch wiring Pin U to yellow S4 wire
Faulty switch wiring | for correct Ie.ss than 1.'0 Ohm and
continuity Pin U to Pin H (earth)
' greater than 1M Ohms)
Trackside Beacon | Check Trackside Green LED on Beacon is
has not been put beacon is outand | illuminated when there is
out/ powered up has power power to the beacon
Trackside Beacon Receiver and Beacon
is not aligned Align Beacon must be parallel and
correctly same height
13 Lap time is not . On car Receiver is
displayed automatically | not aligned Align Receiver
correctly
Lap marker Check lap marker Dis-connect receiver and

press lap switch 4.

Lap marker
receiver faulty

Replace lap marker
receiver

If display changes,
replace Receiver after
checking its wiring.
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No. Symptom Possible Cause Remedy Notes
System configured
) with wrong number
Igzp:]?ysc:)rsgeoeg)v\\llatljue of ta:g(_ats per wheel Reconfigure the
14 9 Yy | revolution system with correct
a constant %-age |
amount. System configured | V&U€S Typical wheel
with wrong circumference for a
circumference. vehicle is 1800mm / 70"
No speed reading.
15 Speed_ readlng erratic, Faulty sensor Check sensor
value jumps high or low | and/or wiring
No alarms for water ol All the al'arrr:]s haf\_f/e Switgh on Ithe Alarms only operate
, Oll, [ been switched o required alarms when the engine is
16 or fuel (temperatures running at the RPM gate
i The engine RPM
and pressures) being gine Reset the RPM gate | value or above it.
displayed gate value is set to a lower value
too high '
Intermittent alarm
Display and alarm light caused by a Either change the Press Switch 2 to see
} parameter with its : . -
17 flash when the engine value for the alarm which sensor is causing
. . alarm level set too
is running or turn the alarm off | the alarm.
close to the normal
operating value
All the alarms have | Switch on the
No alarms for water, oil, | been switched off required alarms Alarms only operate
18 or fuel (temperatures : when the engine is
and pressures) being The engine RPM Reset the RPM gate | 'Unning at the RPM gate
displayed gate value is set to a lower value value or above it.
too high '
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Data Analysis Software Problems

GENERAL DATA ANALYSIS SOFTWARE PROBLEMS

Fault Description

Possible Cause

Remedy

Notes

'Insufficient Memory'
error

Insufficient conventional
RAM Memory

Ensure all other
program drivers are
loaded into high
memory

Run program in
MS_DOS mode

Ensure sufficient RAM
Memory is available

Create separate DOS
partition

Ensure sufficient RAM
Memory is available

Histogram program or
Map program "Crash"

Insufficient conventional
RAM Memory

See above

'Invalid Directory Bad
Command or File
name, error

Software installed to a
different directory

Edit <run>.BAT file and
enter the correct
directory path

‘Demonstration Version'
errors or... Inconsistent
menu options and or
operation

ST800.INI file corrupted
or erased

Replace by Copying
ST800.0RG file to
ST800.INI
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Dash Logger for Porsche GT3

BACKUP, ARCHIVE AND RESTORE PROBLEMS

Fault Description

Possible Cause

Remedy

Notes

‘Nothing to Do' error
when backing up,
archiving or restoring
data

Selected data does not
exist and hence cannot
be backed up, archived
or restored

Use DOS UNDELETE to
recover data. See DOS
user guide for details

You must exit the
program and return to
the DOS prompt C:> to
do this

Duplicate action, data
has already been
backed up, archived or
restored

No action required

'Could not create
destination directory'
error when backing up,
archiving or restoring
data

Floppy disk Write
protected

Remove disk and
check that the hole is
blanked off

Disk contains a file of
the same name as the
track

Use DOS to Rename
the file See DOS user
guide for details

You must exit the
program and return to
the DOS prompt C:> to
do this

"Target disk not
accessible' error when
backing up, archiving
or restoring data

Disk not placed in
appropriate drive

Insert disk into the
drive.

Check that the correct
drive is specified by
archive_dir=in
ST800.INI file

Menu options scroll
over the top of screen

Unexpected DOS/Disk
error has occurred

Press the 'F' key to
recover

Press the 'A' key to
return to DOS

‘Error creating
compressed file' when
backing up, or
archiving data

Floppy disk is full

Insert blank disk into
the drive

Do not forget to label
the disk with the track
and session

Too many runs in one
session to fit onto one
disk

Use HD 1.44Mbyte disk
in place of a DD
720kbyte disk
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Troubleshooting

DATA RECORDING AND DOWNLOADING PROBLEMS

Symptom

Possible Cause

Remedy

Notes

Download fails with
‘Download incomplete’
Error

Logging system not
powered

Check for power to the
logging system and
retry

Logging system is in
setup mode

Power the logging
system off then on and
retry

Wrong parallel port
connection

Check the Port=
parameter in the
ST800.INI file

See section 10
"Optimising and
Customising Your
Software"

Check the lead is
plugged into the correct
port
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Dash Logger for Porsche GT3

PC DISPLAY PROBLEMS

Symptom

Possible Cause

Remedy

Notes

No data visible in chart.
Numbers on Left Axis
incorrect

Incorrect chart range

Use Edit O Chart
Range to enter the
correct Min and Max
values of the chart

Chart displays 'Warning
Data channel not
recorded' error

Data has been Archived
onto floppy and not
restored

Use File O Restore
Data to recover data

Download of Data did
not complete
successfully

Use Recorder O
Download, to
Download data

Invisible peak or trough
in data graphs. Values
at bottom of chart are
correct

Incorrect chart range is
truncating data outside
the Min Max range

Use Edit O Chart
Range to enter the
correct Min and Max
values of the chart

Laps within two runs do
not align, or overlay
correctly (All laps

Lap Beacon was moved
or placed differently for
each run

Use Alt+A to realign
data

Always site the Lap
beacon in the same
place

affected)
The value for the track Use .Edlt 0 Track Use Options[]
Details to reset the
length has been Calculate to correct the
Track length and
changed affected runs
tolerance
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PC DISPLAY PROBLEMS

Symptom

Possible Cause

Remedy

Notes

One or more Laps
within two runs do not
align, overlay correctly
(Not all laps affected)

Lap Beacon was missed
on one or more laps for
one or both of the runs

If the lap times are
known use Edit [0 Run
markers to insert the
missing lap times

Track tolerance set too
tight

Use Edit O Track
Details to increase the
Track tolerance

Check alignment of both
the transmitter and the
receiver

Chart displays blank
graphs, may have
correct speeds at
bottom of chart

Insufficient number of
Files specified in
CONFIG.SYS

Check the Files= 40
parameter in the
CONFIG.SYS file

To do this, Exit the
program and retumn to
the DOS prompt C:\>.
Reboot the PC after
changes
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Dash Logger for Porsche GT3

APPENDIX A. SUMMARY OF SWITCH FUNCTIONS

Normal Operation

Functions Switch or Switches
Show Peak Values Switch 1
Change Display Layer Switch 3

Clear Alarm Switch 2 or Switch 3
Show Last Alarm Switch 2
Manual Lap Marker Switch 4
Latch Speed Display Switch 1

Reset Peak Values

Switches 1 & 3 together

Reset lap count and lap time to zero

Switches 1 & 4 together

Put system into configuration mode

Switches 1 & 2 together

System Configuration Mode

parameter being displayed

Functions Switch or Switches
Decrease the alarm value of the )
) : Switch 1
parameter being displayed
Increase the alarm value of the Suiitch 2

Enable or disable an alarm for the
parameter being displayed

Switches 1 & 2 together

Display the next configurable parameter

Switch 3

Quit configuration mode and return to

normal mode

Switch 4
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Dash Logger for Porsche GT3 Index
A D
About 43 Delete Run 39
alarms 2, 9 digital display panel 6
alarms, switching on or off 2, 12 Display
analog tachometer 6 Chart 41
Archive default drive 3, 27 Histogram 41
Archive Session 31 Report 41
B Display Layer 1 2, 6
Display Layer 2 2, 6
Backup Session 31 display layer 3 2, 7
Backup Setups 31 Display Layer 4 2, 7, 14
battery voltage 6 display layers 6
C display module 6
display options 27
Calculate 43 displays 27
Calibration Download, Display Run 39
Information Copying 38 Download, Erase Memory 40
Suspension 35 Download, Save Memory 40
Chart 41 Downloading Data 39
<< 48
>> 48 E
Chart Menu 3, 47 Editor Functions 36
Files Menu 3, 45 EMS Memory 3, 26
Help 48 Erase Memory 40
Move Menu 3, 46 Exit 32
Notes 3, 47
Reference Menu 3, 45 F
Reports 47 fastest lap time 7
Chart Ranges 32 fuel pressure 6
clearing an alarm 10 G
configurable parameters 11
Configure Network 43 gate value 7, 9
configuring the display system 2, 11 gear shift light 10
Copy Setup to Run 38 H
current speed 6, 7
Histogram 41
<< 56
>> 56
Files Menu 4, 55
Help 56
Histogram Menu 4, 56
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Move Menu 4, 55
Notes 56
Reference Menu 4, 55

I

Index 43
Installation
With Version 6 3, 21

K

Keyboard
for Menus 29

L

lap number 7

lap time 7

lap times 2, 10

lap timing sensor 2, 15

lateral G-force sensor 2, 17, 18

M

Main Menu 3, 29
Display Menu 3, 41
Edit Menu 3, 32
File Menu 3, 30
Help Menu 3, 43
Options Menu 3, 43
Recorder Menu 3, 39
System Menu 3, 43
Utils Menu 3, 43

Make New Setup 38

Marker Types 39

Memory requirements 3, 26

Monitors 3, 27

Mouse
for Menus 29

Move Setups 32

N

Network Interface Adapter 28
Notes Editor 36

@)

oil pressure 6
oil temperature 6
Operating System 3, 26

P

peak value memory 2, 9

peak values (tell tales) 2, 7

peak values, resetting 2, 8

Port Assignment 3, 28

power supply to trackside beacon 2, 16

R

Ranges
Chart 32
Real Time Display 43
Report 41
<< 53
>> 53
Edit Menu 3, 53
Files Menu 3, 52
Help 53
Move Menu 3, 52
Notes 53
Reference Menu 3, 52
Reports Menu 4, 53
resetting the peak values 2, 8
Restore Session 31
Restore Setups 32
RPM gate value 7, 9
Run
Select 31
Run Details 36
Run Markers 39
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Index

S

Screen Mode 43
Select Run 31
Select Track Map 43
Session
Archive 31
Backup 31
Restore 31
Setup
Backup 31
Changing Vehicle Setups 34
Move 32
Restore 32
Shell to DOS 43
showing the last alarm 10
ST800.INI File 3, 26
ST800.ORG file 3, 28
Standard components 5
Standing quarter mile. See Distance timer
Start Logging 40
Stop Logging 40
Storage requirements 3, 26
switches 2, 13
System Diagnostics 43

T

tachometer 6
Track Details 37

U

Using Chart 3, 44
Using Histogram 4, 54
Using Report 48

W

warning lights 2, 13
water temperature 6
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